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Introduction

To control and decrease the public health impact of human protozoan diseases such
as Chagas disease, leishmaniasis, and human African trypanosomiasis, expediting
the development of new drugs and vaccines is necessary. However, this process
is filled with difficulties such as highly complex parasite biology and disease
pathogenesis and, as typical for neglected tropical diseases, comparatively limited
funding for research and development. Thus, in vitro and in vivo study models that can
sufficiently reproduce infection and disease key features while providing rational use
of resources are essential for progressing research for these conditions. One example
is the in vivo bioluminescence imaging (BLI) mouse model for Chagas disease,
which provides highly sensitive detection of long wavelength light generated by
Trypanosoma cruzi parasites expressing luciferase. Despite this technique becoming
the standard approach for drug efficacy in vivo studies, research groups might still
struggle to implement it due to a lack of proper practical training on equipment handling
and application of quality control procedures, even when suitable BLI equipment
is readily available. Considering this scenario, this protocol aims to guide from
planning experiments to data acquisition and analysis, with details that facilitate the
implementation of protocols in research groups with little or no experience with BLI,

either for Chagas disease or for other infectious disease mouse models.

Chagas disease is endemic in Latin America and affects
approximately seven million people worldwide®. Annually,
more than 50,000 deaths and economic losses of around
7 billion dollars result from the disabling nature of this

2

disease“. Chagas disease is caused by the protozoan

Trypanosoma cruzi, a heteroxenic hemoflagellate parasite
capable of infecting mammals (wild and domestic) and
triatomine vectors (Hemiptera, Reduviidae)3 in the Americas,
where the vectorial transmission is established. Other

important infection routes include blood transfusion, organ
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transplantation, oral (by the ingestion of food contaminated
with an infected triatomine)4, and congenital transmission.
Non-vectorial transmission routes have contributed to the

spread of Chagas disease to non-endemic areas®:°.

Chagas disease manifests in two clinical phases. The
acute phase is, in most cases, asymptomatic. Symptomatic
infections are usually associated with non-specific signs such
as fever, fatigue, myalgia, lymphadenopathy, splenomegaly,
and hepatomegaly. The acute phase is also often
associated with patent parasitemia and systemic circulation
of parasites. Death may occur in up to 10% of the
diagnosed cases, especially in those of oral infection®.
The chronic phase is often characterized by a long period
of absence of any symptoms. With time, approximately
one-third of the patients infected decades earlier exhibit
cardiac manifestations, usually accompanied by fibrosis and
myocardial inflammation, and/or gastrointestinal disorders
mostly related to the development of megaesophagus and/or

megacolon syndromes3:2:6.

The etiological treatment of Chagas disease consists of only
two drugs: benznidazole and nifurtimox. These antiparasitic
agents have been available for over 50 years and have
considerable toxicity and limited efficacy5 7.8, Consequently,
there is a pressing need to develop new, safe, and more

efficacious treatments for Chagas disease patients.

More sophisticated and accurate techniques make it possible
now to obtain answers to old questions that allow advances
in the search for new treatments for Chagas disease. In
this sense, the scientific community greatly benefits from
genetically modified parasites for in vivo studies on the course
of infection and evaluation of drug eﬁicacy9'10'11’12. A
longitudinal assay based on the bioluminescence imaging

(BLI) system allows efficacy evaluation during and after the

treatment regimen, leading to the identification of compounds
with trypanocidal activity10’13. The BLI method provides
a direct measurement of parasite load, both in circulation
or in tissues and organs, through the quantitation of light
produced by the genetically modified T. cruzi CL Brener
Luc::Neon Iineage11 , Which constitutively expresses the red-

shifted firefly luciferase 2.

Nonetheless, nearly 10 years after the establishment of
the Chagas disease BLI animal model and drug efficacy
studies, only a few research groups dominate this technique.
This fact is due to not only the reduced access to proper
imaging equipment but also the lack of training and availability
of structured, detailed protocols. This method presents
several advantages over other approaches, which rely on
the assessment of parasitemia by microscopy, serology, or
organ/tissue infection evaluation by qPCR for parasite DNA
detection, as it allows improved mice well-being and reduction
of animal use by the possibility of generation of more robust
and integrated data in vivo. Furthermore, this method is,
arguably, more sensitive, as it enables ready detection of
parasite foci in visceral organs after drug treatment'0-12,
Therefore, this protocol aims to guide research groups on
Parasitology and other infectious diseases to establish this
methodology in their laboratories by detailing the technical
procedures. Here, we share the experience obtained through
implementing of the Chagas disease BLI model in Brazil, the
first of its kind in Latin America, as part of the drug discovery
efforts coordinated by the Drugs for Neglected Diseases

initiative (DNDi).

Protocol

All procedures described in this protocol were submitted,

approved, and conducted according to the guidelines14

preconized by the Animal Ethics Committee of Instituto de
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Ciéncias Biomédicas at Universidade de S&o Paulo: protocol

CEUA ICB/USP no 5787250522.

1. Solutions

NOTE: Consider the preconized administrated volume of 10

mL/kg (200 uL for a mouse 20 g weight)15'16. For instance,

prepare a 15 mg/mL working solution to reach 150 mg/kg of

animal dosing.

2.

Hydroxypropylmethylcellulose vehicle

(HPMC-SV)

suspension

NOTE: The reagents required are 0.5% (w/v)
Hydroxypropylmethylcellulose (HPMC), 0.4% (v/v)
Tween 80, and 0.5% (v/v) Benzyl alcohol.

1. For 200 mL of vehicle solution, weigh 1 g of HPMC
and dissolve in 64 mL of hot ultrapure water. Stir for

2 min.

2. Add 120 mL of ice-cold ultrapure water and stir for 1

h. Add 1 mL of benzyl alcohol.

3. Then add 0.8 mL of Tween 80 using the reverse
pipetting technique and keep stirring until the

solution becomes transparent.

4. Adjust the solution for the final volume of 200 mL.
Store the HPMC-SV under refrigeration (4 °C) for a

maximum of 3 months.
Benznidazole

1. Calculate the necessary amount of compound
solution, as follows:
volume of compound solution = (number of doses
in each day x number of days x number of mice to
be treated x administered volume in each mouse) +

30% extra.

2. Weigh the necessary amount of benznidazole
(BZ), considering the desired dose. For curative
treatment, an oral dose of 100 mg/kg once daily for
10 days achieves a 100% cure in the CD chronic

model'”.

3. Considering the desired final volume, calculate the
proper amount to reach a concentration of 5% (v/v)

DMSO and completely dissolve BZ in neat DMSO.

4. Add the proper volume of the vehicle to a glass tube

to reach a concentration of 95% (v/v) HPMC-SV.
Transfer the BZ dissolved in DMSO to the glass tube
containing HPMC-SV. Vigorously homogenize the
suspension and store it at 4 °C.

E.g.: Final volume of the BZ formulation = 10 mL
(step 1.2.1)

Amount of BZ = 100 mg (step 1.2.2)

5% DMSO = 0.5 mL (step 1.2.3) and 95% HPMC-
SV =9.5mL (step 1.2.4)

5. Before each drug administration, the formulations
are placed in an ultrasonic water bath for 5 min at 37
°C and vigorously homogenized before the animal

dosing.
Cyclophosphamide

1. Dissolve the necessary amount of
cyclophosphamide in ultrapure water to achieve a

12.5 mg/mL solution.
2. Sterilize the solution by filtration and store at 4 °C.
Giemsa stain

1. Dissolve 0.6 mg of Giemsa powder reagent in 50 mL
of methanol. Add 25 mL of glycerol and mix. Remove

precipitates using filter paper and a funnel. Store the
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stock solution at room temperature (RT), protected

from light.

2. Prepare a working solution by diluting 10 mL of
Giemsa solution in 90 mL of Mix-Phosphate Buffer

(20.5 M NayHPO,, 65.4 M KH,POy at pH 7.2).
2. Trypanosoma cruzi culture

1. Working in a biological safety cabinet (BSC), cultivate
4 x 108 epimastigotes/mL of T. cruzi CL Brener

Luc::Neon'" in LIT media (68.44 mM NaCl, 5.36 mM KCl,
112.7 mM NagoHPOy, 5 g/L tryptone, 5 g/L liver infusion
broth, 0.03 M hemin, 4.16 mM glucose), supplemented
with 10% (v/v) Fetal Bovine Serum (FBS), 100 pg/
mL penicillin, 100 U/mL streptomycin and 150 pg/mL
hygromycin as selective drug at 28 °C. The parasites

typically achieve a stationary phase in 3-4 days.

2. Induce metacyclogenesis to obtain infectious parasites

by incubating 3 x 108 epimastigotes in 10 mL of Grace's
Insect medium with 10% (v/v) FBS in 15 mL conical tubes

at 28 °C for 7-10 days.

3. Evaluate the differentiation rate by Giemsa-staining
smears. For that, spread 20 pL of the differentiated

parasites in a glass slide and let dry for 10 min.

4. In a fume hood, proceed with the sample fixation by
covering the glass slide with neat methanol and let dry
completely (1-2 min). Cover the glass slide with Giemsa

working solution for 20 min.

5. Gently wash the glass slide with distilled water. In
a microscope, count the percentage of metacyclic
trypomastigotes. If a differentiation rate of at least 10

percent is achieved, proceed to the next step.

6. Centrifuge the parasites (120 x g for 10 min) and
resuspend the pellet with 10 mL of DPBS. Centrifuge
once more and resuspend the parasites in 5 mL of
DMEM supplemented with 10% (v/v) of FBS, 100 ug/mL

penicillin, and 100 U/mL streptomycin.

7. Ina25cm? culture flask, perform the infection of 1.66 x
10% LLC-MK2 cells (kidney epithelial cells from Macaca

mulatta) at 37 °C in 5% COy, in a humidified incubator'®.

8. Tissue-culture trypomastigotes (TCTs) are released in
the medium after 8-9 days. Infect fresh LLC-MK2 cells
monolayers with TCTs at a multiplicity of infection (MOI)

of 1:40.

3. Analysis of Trypanosoma cruzi population
homogeneity by flow cytometer

1. Collect TCTs of CL Brener Luc::Neon and CL Brener
wild-type strains, centrifuge at 120 x g for 10 min, and

resuspend the TCTs in DPBS. Adjust the parasite density

to achieve 1 x 108/mL.

2. Proceed with population analysis by flow cytometer

based on mNeonGreen fluorescence (ex. 506/em. 517

nm)19, acquiring at least 20,000 events for each sample.
NOTE: The fluorescent population percentage is
obtained by comparing the wild type against the
transfected parasite. To proceed with the mice infection,
a minimum of 95% of the fluorescent parasite population
of the CL Brener Luc::Neon lineage should be achieved

(Supplementary Figure 1).

4. Mice experimental infection

NOTE: To increase the amount of parasites,

bloodstream trypomastigotes (BT) are frequently obtained

10,13

from immunodeficient mice Here, chemical
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immunosuppression of BALB/C mice is used to obtain BT.
For that, mild immunosuppression is achieved with four
intraperitoneal injections of cyclophosphamide (CTX) at 62.5
mg/kg with 96 h intervals, which is performed concomitantly

to T. cruzi infection.

1.  Administer 62.5 mg/kg of sterile cyclophosphamide by
intraperitoneal injection (i.p.) 1 day before the T. cruzi

infection.

2. Infect each mouse with 1 x 10* TCTs in 0.2 mL of DPBS
through the intraperitoneal route. Attention to the high
risk of incidents when handling pathogens and needles.
Perform the infection in a BSC, wearing gloves and a face

shield during the entire procedure.

3. Monitor the parasitemia daily by direct observation of

the BT in the blood (Pizzi-Brener method)??. At the
parasitemia peak, around 13-17 days post-infection
(dpi), conduct the blood collection. For that, anesthetize

mice with 100 mg/kg ketamine and 10 mg/kg xylazine.

4. When mice are completely anesthetized?’, proceed with
the cardiac puncture using a 1 mL syringe attached to a
24 G X% needle containing 50 pL of 3.8% (w/v) sodium
citrate. Unplug the needle and gently place the blood in

a centrifuge tube.

5. In a BSC, perform a dilution of an aliquot of blood in
ammonium-chloride-potassium (ACK) lysis buffer and
count the parasites in the Neubauer chamber. Repeat
this procedure at least twice, as small blood clots
influence parasite counting.

NOTE: To prevent counting errors, adjust the dilution
factor to avoid counts lower than 30 and higher than 300

trypomastigotes in the Neubauer chamber.

6. Adjust the parasite density to 5 x 103 BT/mL by mixing

the necessary amount of pure blood in DPBS.

7. Infect non-immunosuppressed BALB/c mice with 1 x

103 BT in 0.2 mL of DPBS per mouse (5 x 108

BT/mL) by intraperitoneal route using a 26 G needle

(narrower needles lead to parasite Iysis)22. After injecting
the volume intraperitoneally, hold the needle inside the

mouse for 5 s to avoid backflow.

8. Place the infected mice temporarily in a box with a paper
towel to identify potential leaking or bleeding and then

return mice to their cages.

5. In vivo imaging
NOTE: Glossary of the terms used here are as follows:

Imaging session: Bioluminescence acquisition performed in
all groups of a certain experiment on a given day. Figure 1A

shows an overview of the procedure.

Imaging round: Procedure performed in subgroups of three
mice, from D-luciferin injection to anesthesia recovery. It is
recommended that each experimental group contain 6 mice,
due to the mice’s intrinsic variability of parasite load and other

factors that influence BLI quantification described below.

Imaging acquisition: Photoshooting performed by the imaging
equipment to quantify bioluminescence, which results in
an image overlay of a photograph and the quantified

bioluminescence shown as a pseudocolor scale.

Imaging procedure: All steps discussed in this session of the

protocol.
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Figure 1: Acquiring BLI data. (A) Diagram of acquisition workflow applied for infectious diseases studies, using the Chagas
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disease bioluminescent mouse model as an example. Mice infected with genetically modified T. cruzi are analyzed by in vivo
imaging on the established time points. On each imaging round, groups of up to three mice are injected with 150 mg/kg of
enzyme-substrate (D-luciferin). After 5 min, anesthesia is administered at 2.5% (v/v) isoflurane in oxygen. When completely
motionless, mice are placed in an imaging system, and acquisition is started following the defined settings. After imaging,
mice recover from anesthesia and are returned to cages. Frequent questions and issues that the researchers might have
and face during acquisition are highlighted in red. This scheme has been modified from Lewis et al. (2014)12 (created with
BioRender.com: UD26KWEVS2). (B) In vivo kinetic of D-luciferin/red-shifted firefly luciferase (PpyRE9h). Mice at the T.
cruzi parasitemia peak (n = 3) were anesthetized and injected with 150 mg/kg D-luciferin. Images were acquired for 1 h
(exposure time: 2 min; binning: 4). Top: ventral total flux (p/s) quantification (left Y-axis, in red) and as percentage of highest
mean measurement (right Y-axis, in blue). Data are shown as mean (curves) and standard deviation (shaded area). Bottom:
Acquired images of the first (4 min), highest BLI signal (30 min), and last (62 min) time points. Please click here to view a

larger version of this figure.

1. Check the green bar in the Acquisition window to verify 2.  Verify if the auto background adjustment was performed.

if the charge-coupled device (CCD) camera is cold (-90 To do so, click on Acquisition > Background > View
°C). Click on the bar (green or red) to visualize the available Dark Charge. A list with several setting
temperature. combinations will appear.

NOTE: According to the imaging equipment manual, the NOTE: This procedure reduces luminescence noise. If
imaging equipment and software should be turned on all the chosen configuration results in a value higher than
the time to keep the CCD cold. 1000, based on the formula "exposure time x (binning?)",

then dark charge should not be ignored. Depending on
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the software configurations, binning can be shown as a
number (binning factor) or a range from ‘small’ to ‘large’.
The correspondence between the range and the binning

factor can be found in the device manual.

If the Activity Window (white area at the bottom of
the software) is not shown, enable it on Menu View >

Activity Window.

Set the imaging area by clicking on Acquisition Window
> Field of View. Option C (13.2 cm) acquires 3 mice,

and Option D (22 cm) acquires 5 mice.

Select the autosave option by clicking on Acquisition >
Auto-Save and select or create a new folder for each

time point.

Lay a matte black paper on the imaging area and place
the partitioning slides perpendicularly between the inlets.
If the manufacturer did not provide the slides, use pieces

(3 cm x 15 cm) of matte black paper.

Adjust the internal area of the imaging chamber to
accommodate the glass nose cones to the anesthesia
inlets. Use small pieces of black electrical tape to attach
the anesthesia system to the platform (outside the image
area).

NOTE: In some versions of imaging devices, a laser
defines the imaging area. If this tool is unavailable,
acquire images through the software to check the

partitioning slides within the imaging area.

Set the isoflurane vaporizer to 2.5% (v/v) in oxygen
for the imaging and induction chambers. Check by

the pressure gauge if the gas is flowing through the

system21.
NOTE: If the imaging device does not have an inhalation
anesthesia system attached to it, other anesthesia

options are possible, such as injectable xylazine and

10.

11.

12.

13.

ketamine?3. In this case, mice recovery is slow, and the

risk of death is high?*.

Fill syringes (31 G needles) with D-luciferin (a

comprehensive protocol to prepare the D-luciferin is
provided by different suppliers)25’26, protect them from
direct light, and prepare a few plastic containers or extra

cages by covering the interior with a paper towel.

Keep a clock/watch nearby to easily track time and a lab
notebook to register mice groups, luciferin injection time,

and any other information during the procedure.

Weigh all mice and register their weight. Mark each
mouse with a pen marker or tattoo on the tail. Keep mice
identification well displayed during the entire experiment.
This step can also be performed on the day prior to the
acquisition.

NOTE: The mark should not occupy a large body area
because the ink may interfere with the bioluminescent
signal. Permanent markers of different colors can also

help to differentiate the groups.

To start the Imaging session, register a background
luminescent image (settings: Exposure Time: 5 min;
Binning: 'large’ or 16", f/stop: 1) of the imaging chamber
without mice. This procedure helps to identify auto
luminescent light sources or undesired issues on the
equipment.

NOTE: Because BLI is based on enzymatic reaction, time
is an essential feature of the experiment. Check all the
items listed above and equipment settings before starting

animal handling.

Inject 150 mg/kg (i.p.) of D-luciferin in the first 3 mice
without reaching internal organs. Place the mice in the

container box to assess whether D-luciferin leaks (bright
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14.

15.

16.

17.

18.

19.

yellow solution). Take notes if this happens and register

the mice group and D-luciferin injection time.

Wait 5 min then transfer the mice to the anesthesia
induction chamber. Turn on the system. It takes around

3 min for mice to be fully anesthetized (absence of

responses like shaking legs, tail, etc.)21 .

Open the imaging device's door, turn on the anesthetic
flow to the imaging chamber, and, at the same time, turn

off the induction chamber.

Place each mouse in the nose cones position: from
mouse 1-3, from left to right side. Gently accommodate
the mice with ventral side up inside the imaging area
shown by the laser. During the accommodation, verify the
mice's ID and position. Do not force the entrance of mice

partially anesthetized in nose cones.

Place the partitioning slides between mice and close the

imaging equipment's door.

Adjust the acquisition settings on the software

Acquisition window, as follows:

1. For non-infected mice, Exposure Time = 5 min /
Binning = 'large’ or '16'
(most mathematically sensitive set of configurations

to set the threshold values).

2. For infected mice in the acute model: Exposure

Time = 2 min/ Binning = 'medium’ or '4".

3. For infected mice in the chronic model: Exposure

Time = 5 min/ Binning = 'large' or '16'".

Verify if the D-luciferin injection time was performed at
least 10 min before starting the acquisition. If not, wait the
necessary period to obtain the images during the peak
of the luciferase signal (Figure 1B); otherwise, click on

Acquire to begin the imaging acquisition.

20.

21.

22.

23.

24.

The Image Labels window will appear after the imaging
starts. Fill the boxes with the appropriate information
about each group, including luciferin injection time,
experiment, mice identification, time point, and any other
desired information that can help in keeping record. This
information will be included in the measurements table

file.

Verify whether the warning sign Saturated Image is
shown at the end of the imaging acquisition. Saturated
images are not acceptable. If this happens, decrease
the binning and acquire a new image. Take notes to

consider in the analysis.

Once the image is acquired, open the imaging machine
door and turn the mice to the dorsal view (back side up).

Perform the acquisition again and label it appropriately.

At the end of this imaging acquisition, turn off the
anesthetic flow. Gently remove the mice from the imaging

chamber and place them in a container.

Record the mice's body weight while observing the
anesthesia recovery. Record any abnormal behavior or
body abnormalities found during the procedure. Once the
mice return to moving, place them in their cages.

NOTE: Verify the BLI intensity for each acquired image.
After the acquisition ends, the recorded bioluminescent
image and the photograph will be displayed on the
software with an automatic scale that should not be
considered. Set the scale defined in data analysis

(described below) on Tool Palette window.

6. Data analysis

NOTE: The above protocol is based on commercial in vivo

imaging software. However, a software license-free version
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can perform the most basic analysis. Software details can be

found in the Table of Materials.

1. Openfiles.

1.

Open the folder that contains the acquired data from
a certain imaging time point by selecting Menu File
> Browser > Select the folder (Figure 2A - Step 1).
NOTE: A new window will open in a table format
with all acquired data saved in the chosen file. It
will display the Click Number sign, which is the
image ID automatically given by the software (data
and hour numbers), the information provided by the
researcher in the Image Labels window during the
acquisition, and acquisition settings. All these data
help sort the images that can be used in the analysis,

given that saturated images must not be used.

Select multiple rows related to the chosen images,
including the non-infected controls. Write down
the image ID in the lab notebook along with the

information registered during the imaging session.

Assemble the selected images by clicking on Load
as Group. This procedure creates a new sequence
image. Therefore, it is possible to adjust features for
all images simultaneously. Save the new sequence
image in a new folder different from the one used
in step 6.1 to facilitate the reanalysis of raw data if

needed.

In the sequence image, identify the binning used
for each image by clicking on Options > Display >
Select Binning Factor (Figure 2A - Step 2). The
acquired binning factor will be displayed at the top of

each image in the sequence.

2.

Correct all binning factors to the same number. To
do so, double-click on the image to be adjusted. On
the Tool Palette window > Image Adjust section,
choose the appropriate binning factor (Figure 2A -
Step 3) - see step 5.18 for binning factor choice.
Perform this procedure in all divergent images.

NOTE: This procedure directly influences BLI
quantification (Table 1) and is further addressed in

the Discussion section.

Set scale.

1.

Distinguish valid bioluminescent signal (above 600
counts according to the device manual) based on
the non-infected control. For that, double-click on the
image of the non-infected mice. Then, in the upper-
left corner of the new window, select the option
Counts in the Units field. Then, adjust the Color
Scale for the minimum value of 600. The resulting
image will be the baseline to set the minimum scale

in radiance.

With the sequence window active, select the option
Radiance in the Units field. Adjust the Color Scale
and Color Table in the Tool Palette. For that,
disable the box Individual in the Color Scale Limits

area.

Mark the boxes Logarithmic Scale and Manual
(Figure 2A - Step 4). Set the minimum scale
numbers according to the non-infected control (as
observed in step 6.8) and the area with the highest
signal as the maximum (as shown in Figure 2A by
the arrows).

NOTE: In vivo 2D light mesurament is a relative
quantification. Different scale values can be found

due to differences in each device’s version and
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3.

calibration. Therefore, the values demonstrated
in the representative results could not fit other
experiments performed on other devices and yet be
equally valid according to the internal controls (non-

infected and infected not treated).

After setting the same scale for all images, double-
click on each image, maximize the window, and
export the image view in an image format (.jpg, -tiff,
etc.) by using the Export Graphics button, naming
the files by treatment_micelD_time point. (Figure

2A - Step 5). Perform this procedure for all images.

Perform measurements.

1.

Choose any image from the sequence and double-
click on it. On the Tool Palette window > ROI tools
section, click on the Square button (Figure 2B- Step

1) and draw a rectangle covering the whole mouse.

Click on the border of the created ROI and copy and
paste the same ROI for each mouse (resulting in
three ROIs in the image). Save the ROIs by clicking
save on the ROI Tools Section. Apply the saved
ROIs for all images by selecting the box Apply to
Sequence, then click on Load. The saved ROIs will

be used for all mice in the entire experiment.

Adjust the ROI position in each mouse to fit the
animal better in the measurement area. When all
mice are labeled, click on the Measure ROIs button
(Figure 2B- Step 2). The ROl Measurements

Table will appear. Select Measurement Types:

Radiance; Image Attributes: All Possible Values;
ROI Dimensions: cm. Then, click on Select All

button, followed by Copy button.

Paste the data directly into a table analysis software
(spreadsheet). Alternatively, export a file in .csv

or .txt format.

4. Work on the data.

1.

In table analysis software, organize the data
by groups (treatment, control non-infected, non-

treated, etc.).

Parasite load is shown as whole-body
bioluminescence. Therefore, arrange the data to
match the same mice's ventral and dorsal Total Flux

values and sum them.

Calculate the mean and standard deviation of
the summed values considering each group (e.g.:
Plot the data

Supplementary Table 1). into

graphing and statistics software.

Prepare a panel with bioluminescent images in an
image or slide presentation software. Place each
mouse in a column and each time point in the row to
build a drug efficacy matrix to facilitate visualization
and interpretation of the data.

NOTE: There is an option to build the images directly
into imaging software without performing step 6.2.4
(View > Image Layout Window). However, the

software interface and tools limit data organization.
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Figure 2: Data analysis steps from setting image scales to quantifying luminescence. (A) Living Image Software view
for image data processing. Step 1: Upload the acquired data as a sequence using the Browser tool. Step 2: Identify the
binning used for each acquisition (will appear on top of the individual images). Step 3: Set all images of infected mice to

the same binning factor and apply binning factor 16 for the non-infected mice. Step 4: Set the color scale manually based
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on non-infected mice (purple arrow), which should be seen on the screen as non-bioluminescent, and infected and non-

treated mice at the highest bioluminescent foci (red arrow), which should be seen as red. Step 5: To obtain an image free

of any written information, double-click on each image and export the image using the Export Graphics button. (B) View of

Regions of Interest (ROI) Tools. Step 1: Draw an ROI covering entirely a mouse and copy and paste the same ROI for each

animal. Save the adjusted ROIs and apply them to all images in the experiment. Step 2: Click on the Measure ROIs button

to generate the table to export as .csv or .txt. Please click here to view a larger version of this figure.

7. Ex vivo procedure

1. Inject 150 mg/kg D-luciferin i.p. in the mouse (one per
ex vivo round) and wait for 3 min. Anesthetize the mice

using 100 mg/kg ketamine and 10 mg/kg xylazine i.p.

2. In a biological safety cabinet, when the mouse is
completely unresponsive to pinching of the paws, cut the
mouse skin to expose the peritoneum (without opening
the peritoneum cavity) and the tissue of the left-side
axillary. Proceed with the exsanguination by cutting the

axillary artery and vessel.

3. Collect the blood using a disposable Pasteur Pipette.
Then perfuse 10 mL of 0.3 mg/mL of D-luciferin in DPBS

solution through the heart’s left ventricle.

4. Lay out the selected organs on pre-established spots
on a Petri dish and soak them in 0.3 mg/mL d-luciferin
solution. This procedure must be performed within 30 min

maximum.

5. Acquire the luminescent image of the excised organs

(heart, lungs, thymus, liver, quadriceps muscle,

mesentery, spleen, kidney, adrenal gland, visceral fat,
esophagus, stomach, small intestine, cecum, colon,

brain, subcutaneous fat, uterus, gonadal fat, bladder, and

peritoneum membrane) using 5 min of exposure time

and binning 16, depending on signal intensity (saturated

images are not acceptable)zz.
NOTE: The same procedure must be performed in a
non-infected mouse prior to the infected ones to set the

threshold.

Representative Results

Using an adequate mouse model based on transgenic
parasites that constitutively express luciferase, it is possible
to reproduce key human T. cruzi infection features causing
minimum harm to the host, allowing real-time tracking of the
parasites by whole-body BLI of the host in a longitudinal

(lifelong) manner, for up to several months 2.

Figure 3 shows a pilot experiment demonstrating the CL
Brener Luc::Neon infection time-course from day 1 post-
infection until 150 dpi in BALB/c mice. In the first 20 dpi,
bioluminescence-inferred parasite burden increases, typical
of parasitemia peak, followed by a sharp decrease in parasite
load, due to mice immune control. Thus, the acute phase of
the infection is considered the first 50 dpi. The chronic phase
is defined when infection reaches a constant bioluminescent

rate, from 100-150 dpi.
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Figure 3: Understanding the model. Kinetics of Trypanosoma cruzi CL Brener Luc::Neon infection in BALB/c mice (n = 11).

Top panel: ventral and dorsal bioluminescent images from different time points for 150 days post-infection (dpi) with 1 x 103

bloodstream trypomastigotes by intraperitoneal injection. Heatmap scale (in Log4g) of bioluminescent signal in radiance (p/s/

cm2/sr). Color code: Purple = 5 x 103; red = 1 x 107 . Bottom panel: bioluminescent signal quantification in Total Flux (p/s) of

whole-body mice. Data are expressed as means (lines) and standard deviations (shaded regions). Periods defined for acute

and chronic phases of infection in this mouse model are highlighted in orange. Luminescence mean values of non-infected

mice (n = 3) are shown as the threshold (light gray line). Please click here to view a larger version of this figure.

The therapeutic outcomes can also be predicted since the
main phases of the infection are well-reproduced in a mouse
model. Thus, BLI is now applied to translational science
through proof-of-concept studies that support decision-
making about compound efficacy potential and progression
in the development pipeline10’27. In the acute mouse model,
the oral treatment should start when the infection reaches the
parasitemia peak (around 14-21 dpi), characterized by a high

number of trypomastigotes in the bloodstream (approximately

1 x 10% trypomastigotes/mL - data not shown) and systemic
infection. In the chronic phase, mice treatment starts at 100
dpi, when the parasite load is comparatively much lower, with

stable subpatent parasitemia.

To demonstrate the application of the protocol described
above in the evaluation of antiparasitic agents, we compared
the treatment efficacy of benznidazole (BZ), the standard drug

used for treatment of Chagas disease, and posaconazole
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(Posa), a sterol 14a-demethylase (CYP51) inhibitor that failed
in clinical trials for Chagas disease, and that has also been
shown to be inefficacious as antiparasitic agent against T.
cruzi in vitro and in vivo, including in the BLI model described

in this protocol13'18*28’29'30.

For the acute mouse model, cohorts of 6 mice per group
were treated orally by gavage31 for 20 days with Posa at
20 mg/kg or BZ at 100 mg/kg, once daily. Mice were also
treated with BZ for 5 days at 100 mg/kg once daily to evaluate
the effect of short treatments. After compound elimination
(10 days after the treatment ended), the BLI-negative mice
were immunosuppressed, a condition that promotes infection
relapse when a parasitological cure is not achieved (Figure

4A). Posa treatment resulted in a 99.49% £ 0.27% (mean

+ standard deviation) reduction in bioluminescence-inferred
parasite burden at the end of the treatment and remained at
similar levels of non-infected mice during the drug compound
elimination period (except for mouse #3, with a transient
signal at 40 dpi, and mouse #2, that demonstrated a weak
BLI spot at 44 dpi). Compared to the non-treated group,
BZ treatment for 20 days reduced 100% + 0.01% the
bioluminescence-inferred parasite burden at the end of the
treatment. In contrast, the short treatment with BZ for 5 days
led to a 99.98% + 0.03% reduction at 19 dpi (similar to the
threshold level). However, in this instance, the BLI reduction
was transient and in the subsequent acquisitions, all mice

presented infection reactivation (Figure 4B).

Copyright © 2024 JoVE Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported
License

jove.com

May 2024 -207 - €66740 - Page 14 of 26


https://www.jove.com
https://www.jove.com/

jove

3

g &

E ’ \ 7 dpi 1314 1819 25 29 34 I B

= [ Jr

3. o o= o L ® b o by @Y

o End

o / point
Infection Treatment Elimination Immunosuppression

B CD Acute model

Foxa 3 mgikg BE 103 mphy 0T 130 mghy

=== Non-reated

=== Posa 20 mglkg UID {20 days)

=== BZ 100 mgikg UID (20 days)
BZ 100 mgikg UID (5 days)

1%10°

£ =
3 £ 1100
£ o 0
3 E E
: I
a T
z H E 1x10
E
=3
= Threshold] m
1=10%
=103
day post-infection
Mon-treated Posa 20 mglkg (20 days) BZ 100 mg/kg (20 days) BZ 100 mgikg (5 days)
£
Y
¢
W
Key:
Copyright © 2024 JoVE Creative Commons Attribution-NonCommercial-NoDerivs 3.0 Unported jove.com May 2024 - 207 - 66740 - Page 15 of 26

License


https://www.jove.com
https://www.jove.com/

jove

Figure 4: Proof-of-concept experiment design and results obtained with bioluminescence imaging in Chagas
disease acute model. (A) Schematic chart of timeline process in acute Chagas disease mouse model for preclinical studies
for assessment of compound efficacy. Black dots: imaging time points. Medicine flask and orange bar: treatment start

and end, respectively. Syringe icon: cyclophosphamide injections. dpi: day post-infection. Color code: gray = non-treated
infection; orange = treatment period; blue = compound elimination phase; yellow = immunosuppression period. (B) Time-
course of treatment of Trypanosoma cruzi. Left panel: ventral bioluminescence images of BALB/c mice (i) non-treated or
treated for 20 days with (ii) posaconazole (Posa) at 20 mg/kg, (iii) benznidazole (BZ) at 100 mg/kg treated for 20 days and
(iv) BZ at 100 mg/kg treated for 5 days with (n = 6/group). All treatments were orally administered by gavage (10 mL/kg)
once a day. Logqg scale heatmap indicates the bioluminescent signal intensity from low level (blue) to high (red). Right
graph: whole-body quantification of bioluminescence imaging data. Data are expressed as means (lines) and standard
deviations (shaded regions). Key: Medicine flask: treatment start (14 dpi); orange bar: treatment end (18 dpi/33 dpi); syringe
icon cyclophosphamide injections (from day 44-53); orange dot: mouse analyzed by ex vivo procedure; § data excluded due

to D-luciferin leakage in urine. (C) Ex vivo procedure for T. cruzi foci detection in organs and tissues. Plate distribution key is

presented at the bottom of the figure (created with BioRender.com: ZY26LG8AOF). Same radiance scale as shown in vivo

panel. Please click here to view a larger version of this figure.

In this model, antiparasitic treatment may reduce parasite
load below the BLI detection limit of 1000 parasites.

0

Thus, mice appear as BLI negative1. To ensure

that a parasitological cure has been achieved, it is
necessary to promote immunosuppression of mice using
cyclophosphamide treatment2?:32, Mice that still have an
undetectable parasite load after drug treatment will become
BLI-positive after immunosuppression. This effect is shown
more extensively by Posa treatment in the acute model,
which promotes parasite relapse. In this experiment, the
ex vivo procedure was performed on mice with the lowest
bioluminescent signal to evaluate parasite tissue tropism
(Figure 4C). Non-treated mice shows strong bioluminescent
signals, especially in the gastrointestinal tract (TGI) and
associated tissues such as visceral fat and mesentery.
In addition, the skin was a site associated with parasite
persistence. Mice treated with Posa presented lower-intensity
bioluminescent spots that were more restricted to the colon,

mesentery, and visceral fat. On the other hand, in mice

treated with a curative treatment regimen, as BZ 100 mg/
kg for 20 days, no bioluminescent signal is detected even
under immunosuppression. Therefore, considering that after
promoting conditions for bioluminescent signal rising above
the threshold level of 1000 parasitesm, and increasing
sensitivity by exposing the visceral organs, it is considered
that BZ 100 mg/kg for 20 days provides sterile cure. The
assessment of sterile cure was previously validated by

different techniquesm' 13,17,33,34

A similar study design was applied to the chronic model
(Figure 5A), in which mice (n = 6/group) started to be treated
at day 100 post-infection. At this point, Posa 20 mg/kg, BZ
at 100 mg/kg, or 10 mg/kg once daily were administered
orally for 20 days. After the drug elimination period, the
BLI-negative mice were immunosuppressed. In addition, to
assess sterile cure, mice that were still BLI-negative at the
end of the immunosuppression phase were subjected to ex

vivo analysis.
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In chronic infection, treatment with Posa at 20 mg/kg led to ~ showed a variable level of BLI signal and distribution (Figure
a decrease of 95.03% % 6.18% in bioluminescence-inferred 5B). Ex vivo procedure revealed that one whole-body BLI-
parasite burden at the end of the treatment and remained at negative mice treated with Posa had a bioluminescent spot in
similar levels of non-infected mice during the drug elimination  the colon detectable via ex vivo examination (Figure 5C).

period. After the immunosuppression, the majority of mice
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Figure 5: Drug assessment experiment design and results achieved in the chronic model of Trypanosoma cruzi

infection by bioluminescence imaging. (A) Schematic chart of experiment design of chronic Chagas disease mouse

model. Black dots: imaging time points. Medicine flask and orange bar: treatment start and end, respectively. Syringe
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icon: cyclophosphamide injections. Dpi: day post-infection. Color code: Gray = non-treated infection; orange = treatment

period; blue = compound elimination phase; yellow = immunosuppression; lilac = relapse. (B) Longitudinal evaluation of

treatment efficacy in the Chagas disease chronic model. Left panel: ventral BLI of BALB/c mice (i) non-treated or treated

for 20 days with (ii) posaconazole (Posa) at 20 mg/kg; (iii) benznidazole (BZ) at 100 mg/kg, and (iv) BZ at 10 mg/kg (n =

6/group). All treatments were orally administered by gavage once a day. Right graph: sum of ventral and dorsal total flux

raw data. Key: medicine flask: treatment start (102 dpi); orange bar: treatment end (121 dpi); yellow bar and syringe icon:

cyclophosphamide injections (from day 131-142). Orange dot: mouse analyzed by ex vivo procedure. ! mouse died during

anesthesia. * Mouse displays abdominal abnormalities. Heatmap Scale (Log1g) indicates the bioluminescence intensity

in radiance unit from low level (3 x 10° as blue) to high (1 x 107 as red). (C) Ex vivo analysis of T. cruzi tropism in tissue.

Bioluminescence detection of excised organs from immunosuppressed in vivo BLI-negative mice after treatment with Posa

and BZ at 100 mg/kg or mice with the lowest signal in non-treated and BZ at 10 mg/kg groups. Plate distribution key is shown

at the bottom of the figure (created with BioRender.com: ZY26LG8AOF). Radiance scale is equal to in vivo panel. Please

click here to view a larger version of this figure.

Treatment with BZ at 100 mg/kg reduced the
bioluminescence to threshold levels (93.87% * 2.14%)
at 122 dpi and forward until the end of the experiment.
Considering ex vivo analysis, BZ achieved a cure rate
of 100% (6/6 mice), as no mice presented a return
of bioluminescent signal even when immunosuppressed
and internal organs were examined. That means a lack
of relapse. Nonetheless, the BZ treatment regimen with
a lower concentration resulted in a slight reduction of
bioluminescence (85.95% + 18.43%) but no cure, as mice
continued to show detectable bioluminescent signal foci
at all subsequent time points. Thus, this model allows
quantitative differentiation between inefficacious treatments
(posaconazole and suboptimal treatment with benznidazole)
and efficacious treatments (optimal dosing and treatment

length with benznidazole).

Supplementary Figure 1: Preinfection analysis of T. cruzi
population expression of luciferase by measurement
of the reporter gene mNeonGreen fluorescence. Flow

cytometry of mNeonGreen fluorescent protein constitutively

expressed by the CL Brener Luc::Neon parasite. Normalized
histogram of parasite number (Y-axis) by mNeonGreen
fluorescence intensity (X-axis). Internal legend demonstrates
the analyzed strain and form, fluorescence median, and
percentage of fluorescence population. Gate lines are defined
by of CL Brener wild type (WT) strain as non-fluorescent

control. Please click here to download this File.

Supplementary Table 1: Example of analysis table in
BLI measurement. Raw data obtained from bioluminescence
imaging quantification of day 19 post-infection in the acute
model used in the representative results shown in Figure
4B. Groups description: Control as non-infected mice (n = 3/
group); vehicle as non-treated infected mice; posaconazole
(Posa) at 20 mg/kg for 20 days; benznidazole (BZ) at 100 mg/
kg for 20 days; BZ at 100 mg/kg treated for 5 days (n = 6/

group). Please click here to download this File.

Discussion

Bioluminescence imaging is a breakthrough method that
allows the detection of a report gene using a visible and

infrared spectrum of electromagnetic radiation. Therefore,
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there is no need for radiolabeled markers to trace your
specimen35. BLI is suitable for rodent models and other
small species. It is very useful for preclinical studies because
it is safer and allows several image rounds, causing
minimal animal discomfort. Besides, in vivo imaging is very
flexible due to the possibility of combining bioluminescence,
fluorescence, and other techniques such as positron emission

tomography36.

Optical imaging is ruled by optical physical properties, like
absorption and scattering. All tissues absorb and scatter light
of distinguished wavelengths differently37. One critical step
is selecting a reporter gene without taking into account the
emitted wavelength of the light produced by the chemical
reaction. While a reporter gene expression level may be
high in vitro in bioluminescent assays, the same levels of
expression may not be achieved when progressing to the in
vivo setting. In this protocol, we used red-shifted Photinus
pyralis luciferase (PpyRE9H)38 codon-optimized version for
trypanosomatidsg, which emits light at 617 nm, one of the
most suitable for in vivo studies3?. Wavelengths longer than
600 nm are less absorbed and scattered by body endogenous
chromophores, especially hemoglobin and melanin. Thus,
red lights can be transmitted through several centimeters of
tissue, allowing the photons to reach the CCD camera even

from within visceral tissues39:49 .

One area of concern in imaging settings is the lack
of a comprehensive understanding of their function and
effects. Binning, a pre-processing technique, combines
the information acquired by contiguous detectors into a
larger pixel. This process enhances the signal-to-noise
ratio, reducing background noise and improving sensitivity.

However, it decreases spatial resolution accuracy, resulting

in a pixelated image*' 42, This trade-off is an important

consideration in your imaging strategy.

Based on the Target Product Profile and Target Candidate
Profile for Chagas disease34, the proof-of-concept study is
focused on sensitivity to detect T. cruzi and help establish if a
new drug candidate can achieve a sterile cure (represented
by lack of relapse after several immunosuppression rounds).
Therefore, we execute the BLI using the highest binning
factor without supersaturating the image. When the image
supersaturates, a new acquisition is performed using a lower
binning factor. During the analysis, a mathematical correction
is applied to the images that required different binning. This
way, the final data should be presented using the same
binning. Table 1 demonstrates the different values obtained
when distinctive binning factors were applied in the same

image and ROls.

Table 1: Influence of binning settings on the BLI
quantification. Quantification of three ROIs on the image
of acute model (d13) and chronic model (d118), analyzed in
different binning factors. Please click here to download this

Table.

Due to the current scenario of Chagas disease in the
clinic, drug discovery efforts aim to completely eliminate
parasites (parasitological cure)27'34. Therefore, the in vivo
preclinical protocol includes approaches that overcome the
limitations of BLI technical sensibility. One of the approaches
is treating the mice with cyclophosphamide to decrease the
immune response that controls the parasite load. Another
strategy is diminishing the tissue deepness and removing
layers of muscle, skin, and fur that obstruct the light path to the
camera. Through the ex vivo procedure, small bioluminescent

spots can be detected, revealing parasite foci below the in
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vivo BLI threshold, as shown in Figure 5C in ex vivo result of

mouse treated by Posa.

Designing a pilot experiment to evaluate the model itself and
the infection dynamics is crucial to establishing an accurate
experiment for antiparasitic drug efficacy assessment. Hence,
the researcher will be able to define the proper BLI settings
and infection time course in advance. In an exploratory
experiment, one tool that can be helpful to define the
acquisition settings is the 'Autoexposure'. With this tool,
the researcher establishes the priority of three settings
(Exposure time, Binning, and F/Stop) to acquire the best
image possible. In particular, the researcher should ensure
thatimages are acquired within the dynamic range of the CCD
camera, without supersaturation or underexposure, which
can be checked through the minimum and maximum limits
of the scale and the autoexposure feature (Menu Edit >
Preferences > Tab Acquisition > Tab Autoexposure). In
this protocol, the camera aperture was set at the maximum
value (F/Stop: 1), and different exposure times and binning
factors were defined for acute and chronic models. These
settings give time predictability to perform different image
rounds simultaneously. Considering the reporter method is
based on an enzymatic reaction, both the biodistribution of the
substrate into the mouse and the luciferase kinetics influence
the bioluminescent signal and, thus, infection quantification
(Figure 1B). Consequently, acquiring images in different
moments of enzymatic kinetics introduces data variability
that cannot be accounted for or corrected and impacts the
total flux (photons/second) or radiance (photons/second/cmzl
steradian) calculation. Besides, T. cruzi infection displays
dynamic spatial positioning in mice (different areas and
tissues, deepness, and parasite load). Hence, establishing a
value of counts to acquire could miss weaker signal sources

(low number of parasites in a certain spot deeper in the tissue)

if another stronger signal's source meets the defined auto-

exposure criteria.

A tricky feature of Living Image software is displaying the
acquired image in an automatic color scale. There is no
option to pre-set the scale to exhibit automatically a brand-
new acquired image according to the selected scale values
(see protocol step 6.2). This situation forces the researcher to
manually change the images one by one to the chosen max
and min values. As a consequence, the non-experienced and
not well-trained users do not have the proper readout during
the acquisition session, and they could mislead the data or
lose important information at that time point. For that, the pilot

experiment is beneficial.

One of the most common questions about the proof-of-
concept experiment design is how to choose the treatment
duration and dose. For new chemical entities, these
parameters are usually defined by the compound potency
and selectivity in vitro, in combination with data generated
by drug metabolism and pharmacokinetics (DMPK) and
tolerability studies conducted prior to testing in vivo for
efficacy. In summary, after identifying compounds that are
able to selectively kill the parasite inside cells, the first
ADME experiments (absorption, distribution, metabolism and
excretion) are performed in vitro to estimate compounds'
aqueous solubility, cell permeability and metabolic stability,
among other parameters. If compounds show a good balance
of in vitro properties (usually defined in target candidate
profiles), then these candidates are progressed to in vivo
pharmacokinetics (PK) studies in healthy mice, which outline
the compound exposure in the blood (and possibly in tissues
as well) and provide a general idea of the tolerability at

17,34,43

different dose levels . Ideally, the goal of the PK

assessment in most infectious diseases is to determine the
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feasibility to reach free plasma concentrations (corrected
for plasma protein binding) that are above the ECg¢/ECgqq
concentrations** - the effective concentration that kills or
at least inhibits the growth of 50% or 90 % of parasites,
respectively - for a sufficiently long period of time. If enough
exposure is achieved at a certain dose level, then this regimen
can used during the efficacy studies using the Chagas
BLI model. For drug repositioning studies, in vitro and in
vivo PK data should be available. A good start for drug
reprofiling is chemical databases such as PubChem?®, which
provide recognized data that can be converted to mice using
allometric scaling46 to estimate safe and non-toxic treatment
regimens to be tested. However, that is not always the case.
PK studies are still an overlooked field in academic science,
and few pharma companies publish their PK results. The
drug discovery science community recommends including
in vivo PK assessment along with in drug efficacy assays
(pharmacodynamics)47. Therefore, preclinical imaging is
compatible with compound measurements simultaneously,

and this associated approach enhances data robustness.

In addition, the mice's handling, weight, and health conditions
are monitored throughout the entire experiment. Signs of
toxicity and side effects such as hunching, shaking, loss
of balance, unwillingness to move, reluctance to feed or
drink, prostration, or any other abnormalities present in
the group or by individual mouse conditions should be
registered and reported in preclinical studies. One of the
goals of optical imaging is to ensure the animals' well-being.
Thus, humane endpoints should be applied in mice with
pain signs described in the 'Grimace scale®8. Also, mice
were weighed weekly during BLI acquisition and, more often,

during drug dosing and CTX treatment. Following animal

welfare regulations, mice that lose more than 20% of body

weight must be immediately humanely euthanized.

The T. cruzi bioluminescent model is now the state-of-the-art
experimental model for the discovering and developing of new
treatments for Chagas disease. A model that replicates key
features of T. cruzi infection and Chagas disease*?, allowing
for real-time monitoring of parasitemia and differentiation
of compounds with varied efficacy profiles associated with
known modes-of-action. BLI is a technique that enhances
assertiveness in identifying infected tissues. It enables
the precise selection of infected tissues to be used in a
broad range of approaches, including all classic methods
already applied in T. cruzi research®-31. Additionally, it
allows researchers to explore cutting-edge technologies and
develop new ones33. In addition, BLI provides improvement
of animal well-being and more rational use according to 3Rs

10,35

principles , all at once.

Several research groups focus on neglected tropical diseases
are placed in countries where in vivo imaging devices
are unavailable. To overcome the current scenario, new
international networks like Global Biolmaging and their
associated consortia promote actions to provide open
access to imaging core facilities and improve staff and
imaging scientists' trainin952’53. These initiatives, along with
friendly user protocols like this one, can afford conditions
democratizing high-end technologies for all researchers.
The implementation of this method in the preclinical drug
discovery offered a solid efficacy readout and predictive value
of clinical outcome facilitating drug discovery for Chagas

disease.
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